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Step 3: Creating Professional-Looking Worksheets in Excel 
 
Course Overview 
 
The course, Creating Professional Looking Worksheets in Excel, is the third course in a 
three part series.  This course is designed to show you specific techniques that will allow 
you to take steps towards creating a well-designed and professional looking document.  
You will learn about formatting, creating headers and footers, and printing.   
 
Course Objectives 
 
After this course, you should be able to: 
 

 Format your Worksheet using techniques such as formatting numbers, aligning 
text, and merging cells.  

 Utilize Special Effects through the use of color, fonts, and shading. 
 Incorporate Headers and Footers.  
 Manage the Print Function by previewing, setting print areas, printing sheets and 

workbooks. 
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Part A: Formatting the Worksheet 
 
Overview 
 
This lesson shows you techniques to format your worksheet.  You will learn techniques 
that will get you started in working towards a professional looking spreadsheet document.   
 
Objectives 
 
After this part of the lesson, you should be able to: 
 

 Format numbers as currency. 
 Format numbers with decimal places and commas. 
 Add percentage signs. 
 Change the date format. 
 Right align and center text. 
 Merge cells together. 

 
Process 
 
Formatting Numbers as Currency 
 
Action Steps 

 What you do What happens 

1.  Select the cells. (Column E) The cells highlight 

2.  Right-click, then trace to and 
click Format Cells. 

Opens a shortcut menu, and then opens 
the Format Cells dialogue box. 
 

3.  Click the Number Page. Opens the number page which lists 
number categories 

4.  Click Currency in the 
Category list box. 

Selects the Currency format and 
displays more options on the Number 
page. 

 

 
To format cells: 
First, select the 
cells. 
Then, right-click 
and choose Format 
Cells. 
OR 
From the menu, 
choose Format; 
Cells. 
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 What you do What happens 

5.  To change the decimal place 
of the figure, use the Decimal 
Places field on the right side 
of the Number page.  Change 
the decimal place to “2.” 

Changes the selected information 
decimal place. 

6.  Click the OK button. Closes the dialog box and applies the 
Currency format to the selected cells, 
as shown in screen shot. 

7.  An alternative method would 
be to use the Increase 
Decimal or Decrease 
Decimal toolbar 

icon.  and the 

Currency Style icon . 

Changes the selected information 
decimal place.  

An example of formatted currency: 
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Format a Percentage 
 
Action Steps 

 What you do What happens 

1.  Select the cells. (Column D) The cells will highlight 

2.  Right-click, then trace to and 
click Format Cells. 

Opens a shortcut menu, and then opens the 
Format Cells dialog box. 

3.  Click on the Number Page. Tales you to the number Page. 

4.  To format the number as a 
percentage, select Percentage 
from the Category list box. 
 

Selects the Percentage format and displays 
the option for decimal places on the right 
side of the page. 

 
5.  Change the decimal place 

field to zero. 
Default is set to 2 decimal places. 

6.  An alternate would be to click 
the Percent Style icon on the 

toolbar  . 

Applies the new format to the cell, as 
shown in screen below. 

7.  Click the Save icon. Saves the workbook. 

An example of a formatted percentage: 
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Format Dates 
 
Action Steps 

 What you do What happens 

1.  Select the cells you want to 
format. (Column F) 

The cells will highlight 

2.  Right-click, then trace to and 
click Format Cells. 

Opens a shortcut menu, and then opens 
the Format Cells dialog box. 

3.  Click on the Number page. Take you to the Number page. 

4.  Click Date in the Category 
list box, and then click on 
your choice from the Type 
list box. 

Selects the Date category, and then 
selects the new date format. 

 
5.  Click the OK button. Closes the dialog box and applies the 

change to the dates in the selected 
cells. 

6.  Click the Save icon. Reveals the worksheet, and then saves 
the workbook. 

 

 
When the number sign is displayed across 
the cell, it means that the column is not 
wide enough to display the cells contents. 
Increase the column’s width. 
 
One way to increase the column’s width is 
to place your mouse pointer in the column 
header on the dividing line between the 
columns. When your mouse pointer is on 
the dividing line, it becomes a double-

headed arrow . Hold down the mouse 
button and drag the dividing line to the 
right, until you have the width you need. 
Then let go of the mouse button.  

An example of a change in the date format: 
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Aligning Text 

By default, Excel left-aligns text and right-aligns numbers, but you can change the 
alignment of any cell.  The contents can be left aligned, right aligned, centered, or 
justified.  You can also center the contents of a cell across an entire range of cells. 
 
Action Steps 

 What you do What happens 

1.  Select the cells you want to 
format. (Column A- Right 
Align, Column D- Center, 
Column F- Left) 

The cells will highlight. 

2.  In the formatting toolbar, click 
on the icon for the type of 
alignment you want.  
left align, center, or right align. 
 

  

Per your selection, Excel 
will realign your selected 
cells. 

A f the re-aligned ce
d C d
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Merge Cells and Center Text 
 
Action Steps 

 What you do What happens 

1.  Select the cells you want to 
format. (A2-F2) 

The cells will highlight 

2.  Click on the toolbar icon, 
Merge and Center, to merge 
the cells into one larger cell 
and then center the text 
within the larger cell. 

 
 
Note:  You can unmerge cells 
by clicking on the Merge and 
Center tool again. 

Per your selection, Excel will 
merge your selected cells. 

3.  Select cells A3-F3. Click on 
the Merge and Center icon. 

Per your selection, Excel will 
merge your selected cells. 

An example of merged cells with text centered: 
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Wrap Text within a Cell 
 
The Wrap Text option specifies that text in the selected cell will break 
into lines within a cell. 
 
Action Steps 

 What you do What happens 

1.  Select the cells you want to 
format. (Column G) 

The cells will highlight. 

2.  Right-click, then trace to and 
click Format Cells. 

Opens a shortcut menu, and then opens 
the Format Cells dialog box. 

3.  Click the Alignment Page. Opens the Alignment Page list. 

4.  Under Text Control, select 
the checkbox for Wrap Text. 

Selects the Wrap Text category. 

 
5.  Select OK Return to your spreadsheet, and your 

selection of cells will be using word 
wrap. 

 
An example of unwrapped text: An example of wrapped text:  
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Part B: Utilizing Special Effects 
 
Overview 
 
This lesson focuses on options that will enhance the appearance of your 
worksheet by changing your text, adding color, applying shading and 
rotating text.   
 
Objectives 
 
After this part of the lesson, you should be able to: 
 

 Change font type and font size. 

 Apply bold and italics. 

 Apply colors, borders, and shading. 

 Rotate Text. 
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Change Font and Font Size 
 
Action Steps 

 What you do What happens 

1.  Select the cells that you want 
to make a font change to. 
(A2 to Tahoma, font 20) 
(A3 to Tahoma, font 16) 

Highlights the cells. 

2.  Click the Font down-arrow 
on the Formatting toolbar, 
then scroll down and click 
Times New Roman or 
whichever font you want. 

 
 

Opens the Font list box, then 
scrolls down the list and 
changes the text to Times 
New Roman or the desired 
font. 

3.  Click the Font Size down-
arrow on the Formatting 
toolbar, and then select the 
size. 

 

Opens the Font Size list box, 
and then increases the font 
size. 

 
To quickly move to 
a particular font 
within the font drop 
down list: 
Click on the drop 
down arrow. 
With the list 
displayed, type the 
first letter of the 
font’s name.  
Scroll if needed. 
Click on the font’s 
name. 

An example of a changed font: 
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Apply Bold and Italic Styles 
 
Action Steps 

 What you do What happens 

1.  Select the cell that you want 
to change. (G6) 

Selects the cells. 

2.  Click the Bold icon on the 
Formatting toolbar. 

  

Applies bold formatting to 
the selected cells. 

3.  Select the cell that you want 
to change. (A6) 

Selects the cells. 

4.  Click the Italics icon on the 
Formatting toolbar. 

 

Applies italic formatting to 
the selected cell. 

5.  To bold or italicize non-
connecting cells, click CTRL 
and click on the various 
desired cells to highlight them 
and then use the Bold or 
Italics icons.   
 
Select cells A8, A10 and 
A12. Apply italics. 
 

This will highlight the 
random cells to which you 
want your formatting applied. 
 

An example of Bold Formatting: 
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Change Text Color 
 
Action Steps 

 What you do What happens 

1.  Select the cells that you want 
to make a font color change 
to. (A2 Dark Blue, A3 Light 
Blue, A6-G6 Dark Pink)  

Selects the cells. 

2.  Click on the Font Color icon, 
then click the color of choice 

 

Opens the Font Color palette, 
and changes the color of the 
text in the selected cells to the 
chosen color. 

The Color Palette: 
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Apply a Single Border 
 
Action Steps 

 What you do What happens 

1.  Select the cells that you want 
to add a border to. (Under 
A6-G6, double line border) 

Selects the cells. 

2.  Click Format, then trace to 
and click Cells. 

Opens the Format menu, and 
then opens the Format Cells 
dialog box. 

3.  Click the Border tab. Reveals the Border card. 

4.  Click the desired Border 
icon(s) in the Presets area 
(None, Outline, or Inside) and 
the Border section. 

Applies a border to the 
bottom of the preview image 
in the dialog box, as shown 
below. 

5.  Select the Style of Border 
from the Line section. 

Applies the style to the border 

6.  Click the OK button. Closes the dialog box and 
applies a single border to the 
bottom of the selected cells. 

The Border Card with the Presets, Border and Style areas marked: 
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Apply Shading 
 
Action Steps 

 What you do What happens 

1.  Press Ctrl+Home, and then 
click the Select All button. (It 
is the gray colored rectangle 
at the junction of the row and 
the column headers.)  
An alternative method is to 
press Ctrl +A. or select the 
cells that you want to shade. 
(Row 7 & Column B) 

Moves to cell A1, then selects the entire 
worksheet or the cells highlighted. 

 
2.  Click Format, then trace to 

and click Cells. 
Opens the Format menu, and then opens 
the Format Cells dialog box. 

3.  Click the Patterns tab. Reveals the Patterns card. 

4.  Click the light yellow color 
located on the third square 
from the left in the fifth row 
of the Color section, or the 
desired color.  Select a pattern 
from the Pattern dropdown, if 
desired. 

Selects a light yellow color and shows a 
preview of how the color will appear in 
the worksheet. 

5.  Click the OK button, then 
click cell A1. 

Closes the dialog and applies the color to 
the worksheet, then selects cell A1. 

6.  Click the Save icon, then 
click the Close Window 
button. 

Saves the workbook, and then closes it. 

The Cell Shading Color Palette and Patterns: 

 

 
After shading is 
applied to the 
worksheet, the 
gridlines are no 
longer visible. 
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Rotate Text 
 
Action Steps 

 What you do What happens 

1.  Select the cell that you want 
to rotate text. (Cell A6, 20 
degrees) 

Selects the cell. 

2.  Click Format on the menu 
bar, then trace to and click 
Cells. 

Opens the Format Cells 
dialog box. 

3.  Click the Alignment tab Returns the Alignment  

4.  Double-click in the Degrees 
text box. 

Selects the Degrees text box. 

5.  Type 20 (for example) and 
click on OK. 

Rotates the text 20 degrees, 
closes the Format Cells 
dialog box, and applies the 
rotation to the cell. 

6.  Your text will not be aligned 
with the text below it. Click 
on the center alignment icon 
on the toolbar. 

The text was previously right 
aligned. When you rotated it, 
the text no longer appeared 
above the text for which it 
was a header. Changing the 
alignment to center will 
improve the text’s 
appearance. 
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Conditional Formatting 
 
Using conditional formatting, you can visually identify critical highs or lows in a report. 
You can specify up to three conditions that apply to the value of a cell or the formula that 
produces the value in that cell.  
 
In this lesson, you apply conditional formatting to the cells in column D. Gray shading is 
applied if the cell’s value is greater than 50% (.50). 
 
Action Steps 

What you do What happens 
1. Click on the header for Column D 

to select all the cells in the column. 
Column D is highlighted. 

 
 

2. From the menu, click on Format, 
Conditional Formatting. 

The Conditional Formatting dialog box 
is displayed. 
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What you do What happens 
3. Click on the down arrow to select a 

math operator. In this example, 
select greater than. 

4. In the edit box (third box), type .50 
(50% expressed as a decimal 
equivalent). 

5. Follow these steps to define the 
formatting that you want the cells 
to have if the condition, cell value 
is greater than .50, is met. 
 
a. Click on the Format button to 
display the Format Cells dialog 
box. 
b. Click on the folder tab for 
Patterns. 
c. Select the fourth color down in 
the far right-hand column. It is a 
gray. 
d. Click on OK. 
 

Here is the Conditional Formatting 
dialog box with the condition and 
formatting defined. 

 
 

6. Click on the OK button in the 
Conditional Formatting dialog box. 

All the cells in column D that meet the 
criterion (cell value is greater than .50) 
are shaded in gray. 
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Part C: Incorporating Headers & Footers 
 
Overview 
 

The Header/Footer card in the Page Setup dialog box allows you set up and preview 
headers and footers for the current workbook.  The Header and Footer list boxes each 
contain a list of preset text, dates, and page numbers that you can apply to the workbook.  
You can also design a Custom Header or Custom Footer to get exactly what you want.  
 
Objectives 
 
After this part of the lesson, you should be able to: 
 

 Create a Header. 

 Create a Footer. 
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Create a Custom Header 
 
Action Steps 

 What you do What happens 

1.  Double-click on the View 
option from the Menu  
Bar. 

Returns to the Page Setup 
dialog box.  

2.  Trace down and select 
Header and Footer. 

Returns Page Setup dialogue 
box. 

3.  Click the Header/Footer tab. Reveals the Header/Footer 
card. 

4.  Click the Custom Header 
button. 

Opens the Header dialog box. 

5.  Click in the Center section 
list box, and then type your 
header. (CONFIDENTIAL) 

Places the insertion point in 
the Center section, and then 
enters the custom header. 

6.  Click the OK button in the 
Header dialog box. 

Closes the Header dialog box 
and displays the new header 
in the Page Setup dialog box. 

7.  Go to Create a Footer on the 
next page. 

 

An example of a custom header in the Page Setup dialogue box: 
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Create a Custom Footer 
 
Action Steps 

 What you do What happens 

1.  Click the Custom Footer button. Opens the Footer dialog box. 

2.  Type your footer in the Left, 
Center, and/or the Right sections 
list boxes. (Left- Class Name, 
Center- Your Name, Right- 
Page Number) 

Enters the text. 

3.  If you want to add page numbers, 
then type Page in the Right 
section list box. 

Moves the insertion point to 
the Right section list box, and 
then enters the text. 

4.  Enter a space, and then click the 
Page Number icon. 

 

Enters a space after Page, and 
then inserts a placeholder for 
the page number. 

5.  Click the OK button in the 
Footer dialog box. 

Closes the Footer dialog box 
and displays the new footer in 
the Page Setup dialog box. 

6.  Click the OK button in the Page 
Setup dialog box. 

Closes the Page Setup dialog 
box and shows the worksheet 
in Print Preview. 

An example of the entry for a custom footer: 

 

 

The header and footer will now show up on any new pages that 
are printed from the Sheet1 worksheet, but they will not appear 
on the other worksheets in the workbook.  To set headers and 
footers for the other worksheets, click the sheet tab for the 
worksheet you want to print, then open the Page Setup dialog 
box and use the Header/Footer card to apply headers and 
footers. 
If you want to use the same header or footer on more than one 
worksheet, first, select the worksheets you want to include.1 
Then, open the Page Setup dialog box and setup the header or 
footer. 

                                                 
1 To select more than one worksheet, hold down the CTRL key and click on the sheet tab for each of the 
sheets that you want to select. The sheet tabs will appear as active, in white. 
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Header and Footer List Box Icons 
 
Excel 2002 has added 3 new icons to this list box – path and file, picture, and format 
picture.  The following defines each of the icons available in the Header and Footer List 
box: 
 

 

 
 

Allows you to change the Header/Footer font. Select the text, and 
then choose the font icon. 

 

 
 

Inserts the page number.  

 

 
 

Inserts the total number of pages.  You can use this in combination 
with the insert page number icon to add “Page 1 of 5” to the 
header/footer of a worksheet. 
 

 

 
 

Inserts the current date.  

 

  
 

Inserts the current time. 

 

 
 

Inserts the path and file name.     

 

 
 

Inserts the file name. 

 

 
 

Inserts the sheet name. 
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Inserts a picture. 

 

 
 

Format a picture.  You must first insert the picture and then press the 
Format Picture icon.  This icon will be unavailable until a picture has 
been added.  

 Page 23 
Ver. 2002.10.03 
Learning Technologies 



Excel:  XP- Step Three  The University of Akron 

Part D: Managing the Print Function 
 
Overview 
 
Excel provides many options that let you specify how you want your work to print.  You 
can choose to print an entire workbook, a single worksheet, a chart, or a selected range of 
cells.  You can change page orientation and scaling, and you can adjust margins and 
centering.  As you make changes, you can use Print Preview to see how your work will 
look when you print it.  When you are ready to print, the Print dialog box will let you 
choose what you want to print and how many copies you want. 
 
Course Objectives 
 
After this part of the lesson, you should be able to: 
 

 Preview your worksheet prior to printing. 

 Adjust page margins.  

 Adjust the centering of the worksheet. 

 Set a print area to print only selected information. 

 Print the entire workbook.  
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Preview the Worksheet 
 
Action Steps 

 What you do What happens 

1.  Click File, then trace to and 
click Print Preview. 

Opens the File menu, and 
then displays the worksheet in 
Print Preview mode.  

2.  Move the mouse pointer over 
the page. 

Changes the mouse pointer to 
a magnifying glass pointer. 

3.  Click the title (or anywhere) 
on the worksheet. 

Zooms in on the worksheet. 

4.  Click the worksheet again. Zooms out to a full-page 
view. 

5.  Click below the scroll box on 
the vertical scroll bar. 

Shows the contents of the 
second page. 

6.  Click the Close button on the 
Print Preview toolbar. 

Closes Print Preview and 
returns to the worksheet. 

An example of Print Preview: 
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Change Page Orientation and Scaling 
 
Action Steps 

 What you do What happens 

1.  Click on the Sheet 2 tab. The second worksheet in the 
workbook is displayed. 

2.  Click on the Print Preview 

icon in the toolbar  .  

The Print Preview view is 
displayed. 
 
Note that there are 2 pages. 
Use the Next button on the 
toolbar to see page 2. 

3.  Click on the Page Setup 
button in the toolbar. 

This works the same as File, 
Page Setup to return the Page 
Setup dialog box. 

4.  Select the Portrait option in 
the Orientation section. 

Specifies that the page will be 
wider than it is tall. 

5.  Select the Fit to Option in 
the Scaling section. 

Specifies that the worksheet 
will be sized to fit on one 
page. 

6.  Click the Print Preview 
button. 

Opens the Print Preview 
window and shows that the 
worksheet now fits on one 
page. 

An example of scaling: 
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Set Page Margins 
 
Action Steps 

 What you do What happens 

1.  Click File on the menu bar, 
then trace to and click Page 
Setup. 

Opens the File menu, and 
then opens the Page Setup 
dialog box. 

2.  Click the Margins tab. Reveals the Margins card. 

3.  Double-click in the Left text 
box, then type 1, or the 
desired spacing. 

Selects the text in the Left 
text box, and then sets the left 
margin to 1 inch. 

4.  Press the Tab key, and then 
type 1, or the desire spacing, 
in the Right text box. 

Selects the text in the Right 
text box, and then sets the 
right margin to 1 inch. 

5.  Click the OK button. Closes the Page Setup dialog 
box and shows the worksheet 
in Print Preview mode with 
new margins. 
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Adjust Centering 
 
Action Steps 

 What you do What happens 

1.  Click File on the menu bar, 
then trace to and click Page 
Setup. 

Opens the File menu, and 
then opens the Page Setup 
dialog box. 

2.  Click the Margins Tab. Reveals the Margin Card. 

3.  Select the Horizontally and 
Vertically options in the 
Center on page section. 

Specifies that the worksheet 
will be centered on the page 
and adjusts the preview image 
to show the change. 

4.  Click the OK button. Returns to Print Preview and 
applies the changes. 

An example after adjustment for centering: 
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Setting Print Areas 
 
Set and Clear a Print Area 
 
Action Steps 

 What you do What happens 

1.  Click cell A1, and then scroll 
down and over to cover the 
area that you want in the 
printing area. 

Selects the cells. 

2.  Click on the File option from 
the menu bar, trace to Print 
Area, then trace to and click 
Set Print Area. 

Opens the File menu, opens 
the Print Area submenu, and 
then sets the area that you 
want to print. 

3.  Click cell A1. Selects the cell. 

4.  Click File, then trace to and 
click Print Preview. 

Opens the File menu, then 
opens Print Preview and 
shows the print area. 

5.  Click the Close button. Closes Print Preview and 
returns to the worksheet. 

6.  Click File, trace to Print 
Area, then trace to and click 
Clear Print Area. 

Opens the File menu, opens 
the Print Area submenu, and 
then clears the print area. 
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Print a Selection 
 
Action Steps 

 What you do What happens 

1.  Click cells that you want to 
print. (Column A- Names) 

Selects the range of cells that 
you want to print. 

2.  Click File, then trace to and 
select Print. 

Opens the File menu, and 
then opens the Print dialog 
box. 

3.  Choose the Selection option 
in the Print what section. 

Specifies that only the 
currently selected cells will 
print. 

4.  Click the Preview button, and 
then click the shaded area of 
the page. 

Opens Print Preview, and 
then zooms in on the 
selection that will be printed. 

5.  Click the page again. Zooms out. 

6.  Click the Close button. Closes Print Preview and 
returns to the worksheet. 

 
To print the selection, 
click the OK button 
instead of the 
Preview button in the 
Print dialog box. 

An example of selected text: 
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Print the Entire Workbook 
 
Action Steps 

 What you do What happens 

1.  Click any visible cell, and 
then press Ctrl + Home. 

Deselects the chart, and then 
moves to cell A1. 

2.  Click File, then trace to and 
click Print.  

Opens the File menu, and 
then opens the Print dialog 
box. 

3.  Select the Entire workbook 
option in the Print what 
section. 

Specifies that the entire 
workbook will be printed. 

4.  Click the Preview button. Shows the Sheet1 worksheet 
in Print Preview. 

5.  Click the Next button, and 
then click the text at the top 
of the worksheet. 

Shows the Sheet2 worksheet, 
then zooms in. 

6.  Click the Setup button, select 
the Gridlines option, and then 
click the OK button.  

Opens the Page Setup dialog 
box, specifies that gridlines 
will print, then closes the 
dialog box and shows Sheet2 
in Print Preview with 
gridlines. 

7.  Click the worksheet again, 
and then click the Close 
button. 

Zooms out to a full-page 
view, then closes Print 
Preview and returns to the 
Sheet2 worksheet. 

8.  Click the Save button, then 
click the Close Window 
button.  

Saves the workbook, and then 
closes the workbook. 

 
To print the entire 
workbook, click the 
OK button in the 
Print dialog box. 
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Appendix: Excel Common Tools And Shortcuts 
 
Standard Tools 
Button Description Alternate Method 

 
AutoSum:  Use the AutoSum button to insert a 
function that totals a proposed range. 

Press [ALT+=]. 

 
Chart Wizard:  Use the Chart Wizard button to 
create or modify a chart. 

Press [F11]. 

 

Copy:  Use the Copy button to place a copy of a 
selected object on the Clipboard for later use. 

Press [CTRL+C]. 

 

Cut:  Use the Cut button to remove the selected 
object and place it on the Clipboard for later use. 

Press [CTRL+X]. 

 

Drawing:  Use the Drawing button to toggle between 
showing and hiding the Drawing toolbar. 

 

 

Format Painter:  Use the Format Painter button to 
copy the formatting of the selected object and apply 
the same formatting to other objects. 

 

 

Insert Hyperlink:  Use the Insert Hyperlink button 
to insert or edit a hyperlink that jumps to another 
document, another application’s file, or another Web 
page. 

 

 

New:  Use the New button to open a new, blank 
workbook.  Any current workbooks will remain open 
in the background. 

Press [CTRL+N]. 

 

Office Assistant:  Use the Office Assistant button to 
open or activate the Office Assistant to get help or 
tips as you work with Excel.  

Press [F1]. 

 

Open:  Use the Open button to open an existing 
workbook on your computer or network. 

Press [CTRL+O]. 

 
Paste Function:  Use the Paste Function button to 
open the Paste Function dialog box to begin creating 
a function. 

 

 

Paste:  Use the Paste button to place a copy of the 
object currently stored on the Clipboard into the 
workbook. 

Press [CTRL+V]. 

 

Print Preview:  Use the Print Preview button to 
activate Print Preview mode, which lets you see how 
your worksheet or print area will look on the printed 
page. 
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Print:  Use the Print button to print one copy of the 
current worksheet or print area using the default print 
settings. 

 

 

Redo:  Use the Redo button to restore an action that 
you have just undone.  Use the down-arrow to open a 
list of actions that can be restored simultaneously. 

Press [F4]. 

 

Save:  Use the Save button to save the current 
workbook. 

Press [CTRL+S]. 

 
Sort Ascending:  Use the Sort Ascending button to 
sort the selected rows in ascending order.  

 

 
Sort Descending:  Use the Sort Descending button to 
sort the selected rows in descending order. 

 

 

Spelling:  Use the Spelling button to check the 
spelling of the worksheet. 

Press [F7]. 

 

Undo:  Use the Undo button to reverse an action that 
you have just performed.  Use the down-arrow to 
open a list of actions that can be undone 
simultaneously. 

Press [CTRL+Z]. 

 
Zoom:  Use the Zoom list box to change how large or 
small the worksheet appears on the screen.  Use the 
down-arrow to open a list of preset options. 

 

 
Formatting Tools 
Button Description Alternate Method 

 

Align Left:  Use the Align Left button to align the 
cell contents at the left edge of the selected cells. 

 

 

Align Right:  Use the Align Right button to align the 
cell contents at the right edge of the selected cells. 

 

 

Bold:  Use the Bold button to apply bold formatting 
to the contents of the selected cells. 

Press [CTRL+B]. 

 

Border:  Use the Border button to apply the current 
border to the selected object.  Use the down-arrow to 
select a different border style to apply to the selected 
object. 

 

 
Center:  Use the Center button to center the cell 
contents in the selected cell. 
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Comma Style:  Use the Comma Style button to apply 
a comma format to the contents of the selected cells. 

 

 
Currency Style: Use the Currency Style button to 
apply a currency format to the contents of the 
selected cells. 

Press 
[CTRL+SHIFT+$]. 

 
Decrease Decimal:  Use the Decrease Decimal 
button to remove one decimal place from the contents 
of the selected cells. 

 

 
Decrease Indent:  Use the Decrease Indent button to 
decrease the indent of the contents of the selected cell 
one character width. 

 

 
Fill Color:  Use the Fill Color button to apply the 
current color to the selected cells.  Use the down-
arrow to select a different color to apply to the 
selected cells. 

 

 
Font Color:  Use the Font Color button to apply the 
current color to the contents of the selected cells.  
Use the down-arrow to select a different color to 
apply to the selected text. 

 

 Font List Box:  Use the Font list box to 
apply an installed font to the contents 
of the selected cells.  Use the down-
arrow to open a list of installed fonts. 

Press [CTRL+ 
SHIFT+F], and then 
press [ALT+DOWN] 
to open the font list. 

 Font Size List Box:  Use the Font Size list box to 
apply a font size to the contents of the selected cells.  
Use the down-arrow to open a list of preset sizes or 
type the size you want. 

Press [CTRL+ 
SHIFT+P], then press 
[ALT+DOWN] to 
open the font size list. 

 
Increase Decimal:  Use the Increase Decimal button 
to add one decimal place to the contents of the 
selected cells. 

 

 
Increase Indent:  Use the Increase Indent button to 
indent the contents of the selected cells one character 
width. 

 

 
Italic:  Use the Italic button to apply italic formatting 
to the contents of the selected cells. 

Press [CTRL+I]. 
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Merge And Center:  Use the Merge and Center 
button to merge the selected cells and center the 
contents in the new cell. 

 

 
Percent Style:  Use the Percent Style button to apply 
a percent format to the contents of the selected cells. 

Press 
[CTRL+SHIFT+%]. 

 

Underline:  Use the Underline button to apply 
underline formatting to the contents of the selected 
cells. 

Press [CTRL+U]. 

 
Navigation Shortcuts 
Objective How To Get There 
Go to cell A1. Press [CTRL+HOME]. 
Move to the end of the worksheet. Press [CTRL+END]. 
Move to the beginning of a row. Press [HOME]. 
Move to the end of a row. Press [CTRL+RIGHT]. 
Move one screen up. Press [PAGE UP]. 
Move one screen down. Press [PAGE DOWN]. 
Move one cell in a given direction. Press one of the arrow keys. 
Move to the edge of the current data region. Press [CTRL] + one of the arrow keys. 
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